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OMNIWEB 5: AN OVERVIEW

Right now, at this very moment, you are looking at the OmniWeb 5 manual, which CLEARLY indicates you are in proud possession 
of the web browser you’ve been waiting for all your life. Well, maybe not “all your life”. Let’s not get too dramatic right off the bat 
here. Plenty of time for that later.

We designed OmniWeb 5 not just to allow you to look at websites, although it does a fine job of that - but also to help you manage 
your web browsing experience completely, without creating a bunch of extra work for you.

Most of you probably know how to use a web browser, and you can transfer those skills to OmniWeb immediately. In fact, if you 
want to, you can simply use OmniWeb just like you would use any other browser. Although, we have no idea why you would want 
to do this, since the point of OmniWeb is to bring you more powerful features that save you time and help you be more productive. 
On the other hand, the fact that OmniWeb’s basic operation is just like any other browser you might have used means that you can 
pick and choose which of its cool features you want to use at any given time.

This manual is intended to give you a decent overview of those features, while hopefully not being too long or boring*. 

Ready to get started? Grab a refreshing beverage, get comfy - and let’s go.  

Congratulations!

*Note that The Omni Group reserves the right to be extremely silly at times. Sorry. We just can’t help it.
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OVERVIEW

Welcome to OmniWeb! Here’s a basic look at your new web browser’s 
interface, and some of the great features you now have access to.

Workspaces save information like which web 
pages you have in your tabs, your history, 
and even the location of your windows on 
your screen. Create a workspace for each 
web activity you do, and instantly switch 
back and forth as needed.

View multiple web pages in a 
single window with drag-and-
drop thumbnail graphics that let 
you easily ID the page you want. Customize OmniWeb’s interface with a host of 

options you configure for the way you work.

Create shortcuts to any searchable website, 
like Google or the Internet Movie Database. 
Stick ‘em in your toolbar, or use keywords 
for fast access.

Tell OmniWeb how you want the web to work. On each individual domain you can choose how to 
interact with its content - from changing the text size, to blocking ads, managing cookies, or telling 
OmniWeb where to save downloads.



Step 1

INSTALLING OMNIWEB

In addition to the OmniWeb application, your CD also 
contains some useful information for helping you get started 
(in case you forgot to look at this manual, but you’re clearly 
smarter than that), and unlicensed versions of The Omni 
Group’s other products for you to try out and fall in love 
with as well.

This is the Licenses window, in which you can keep track 
of any OmniWeb license(s) you may own (for more 
information about its general use, see the online help.)

Step 4

Step 3

Step 2

Insert the OmniWeb CD into your Macintosh’s CD-ROM drive. You should 
see a window similar to this one:

If you want, you can go ahead and run OmniWeb now by double-clicking 
the OmniWeb icon. But you probably don’t want to run OmniWeb from 
the CD, since you’d have to have said CD in your computer all the time. 
Instead, you should drag the icon to a folder on your local or network 
disk. 

Where you put it is up to you; however, most Mac OS X applications 
work best if you put them in the main Applications folder on your hard 
disk. If you have multiple users on your computer, OmniWeb will then 
be accessible to all of them. (Note that you’ll have to be logged in as an 
administrator to write to the Applications folder.)

If you’re the administrator of a Mac OS X network (you’d know if you 
were) and you’ve bought multiple copies of OmniWeb, you may want 
to put OmniWeb in the /Network/Applications folder so that it can be 
available to all network users.

Run OmniWeb for the first time by double-clicking on its icon. You’ll 
be presented with a panel letting you know that you should enter your 
license key. Click Licenses…, and a new window will appear:

Click Add License…, and a sheet will appear in which you can enter your 
license information as it appears on the CD sleeve. Also, here you can choose 
to install your license for Personal, Computer, or Network use. Once you’ve 
entered the license information, click Save to save it (as you might expect).



• A Personal license is available only for you, the user who installed it. It’s stored in your home folder, so 
it is only available when you’re logged into your account.

Personal, Computer, or Network? Huh?

There are three ways you can use your license 

1

2

3

• A Computer license is what you would usually choose: it’s available to any user who can log in to your 
Mac.

• A Network license is available for any user on any machine on your Mac OS X network, and is 
generally only used if you have bought lots of licenses (for instance, at a university lab).

OmniWeb’s license terms

Each OmniWeb license you buy allows you to either:

• Have as many users you want use OmniWeb on one machine.

When installing OmniWeb, you’ll want to decide who else can use your license (see OmniWeb’s license terms below).

1

2 • Have one user use OmniWeb on as many machines as one wants.

or



WHAT’S NEW IN OMNIWEB 5?

There are lots (LOTS!) of changes in OmniWeb 5, but the four most obvious are 
Tabs, Workspaces, Bookmarks and enhancements to how Preferences work.

If you aren’t familiar with tabs, the idea is to allow you to have a bunch of open pages in a single window, therefore 
reducing your screen clutter.  Not only that, but you can organize your browsing by keeping related pages together in 
the same window. 

OmniWeb 5 tabs are smarter than the average bear. Er, smarter than the average tabs. Our tabs provide you with real information about 
the pages they represent, which makes them both more powerful than standard tabs and also - bonus! - easier to use. OmniWeb builds on 
the tab concept by offering thumbnails with uber-cool drag-and-drop capabilities.

When you create a new tab in your tab drawer, the page is represented by a thumbnail graphic of the website it represents. You can switch 
between tabbed pages just by clicking on the thumbnails. Drag thumbnails to change their position in the tab drawer, drag links into the tab 
drawer to create new tabs, or drag and drop tabs from one window to another. If you have a large enough screen, you can even resize the 
thumbnails and read webpages right there in the tab drawer. 

Tabs

Most folks have different browsing personalities, and that’s okay! No therapy is needed, honestly. Sometimes you’re 
shopping, sometimes you’re blogging, sometimes you’re doing research, sometimes you’re running auctions, and sometimes 
you’re reading web comics while you’re supposed to be working on a software manual...

There’re probably some number of related sites you need to visit every time you switch personalities. Blogs you read on a daily basis, say, or 
several different science sites for that term paper. If you’re switching gears, and looking at a lot of different websites, pretty soon you’ve got a real 
mess of unorganized windows and pages. And woe unto you if you need to reboot your computer, or quit your browser, and you lose the whole 
enchilada.

OmniWeb 5 workspaces to the rescue! Using this feature, you can save your individual browsing sessions in one convenient location. When you 
use a workspace, OmniWeb saves information like which web pages you have in your open tabs, your history, and the location of the windows on 
your screen. You can drag and drop windows between workspaces (does that recipe for tiramisu not belong in your Gardening workspace? Drop 
it into your Recipe workspace). Capture the current state of a workspace by taking a snapshot, then restore it whenever you want, clearing away 
any changes made to the workspace in the meantime. Move between workspaces just by clicking on their names. You can even mail a workspace 
to another OmniWeb 5 user, sharing an entire browsing experience by sharing just one file. Don’t bogart the tiramisu, dude.

Workspaces



So that’s a quick look at what’s new in OmniWeb. Now let’s delve into the nitty-gritty. We’ve designed this documentation as an extended 
Frequently Asked Questions list, so it’s like we’re sitting here having a pleasant chat with you, answering your questions. Over coffee, maybe. 
(What? Come on, it’s sort of like that!) The questions are organized by general area of inquiry, and within each section of the manual, you’ll 
find a listing of all the questions on that topic area. 

Remember, if you ever need specific information about menus and commands, refer to the online help, or use the Send 
Feedback item under the Help menu to send email to our elite team of support ninjas.

OmniWeb 5 offers you the most powerful bookmarks we could cram into the application - and believe me, we used a crowbar.  
We’ve added new ways to obtain bookmarks, new things to do with them once you have them, and new ways to organize 
them.

If you’re the generous sort, OmniWeb now lets you share your bookmarks using Rendezvous, so your favorite websites are accessible to 
other OmniWeb users on your local area network. Additional bookmark features include a listing of all web servers available on your LAN 
and filtered views of bookmarks and history (see what websites you have visited most often, for instance). OmniWeb 5 can tell you which of 
your bookmarked pages have new content since the last time you visited each one. And hey, now you can view XML/RSS feeds right in your 
bookmark window. Cool.

As your collections of bookmarks gets bigger, it’s harder to find what you’re looking for - so we’ve built in a super handy search feature. You 
can also define shortcuts for bookmarks, so you can instantly get to a bookmarked page just by typing the shortcut in the Location bar — no 
need to even visit the bookmarks page. But don’t be a stranger! To the bookmarks page! We built all this just for YOU.

When you cut through all our hyperbole - I mean, ha ha, “objective description of features”, at the end of the day this is the 
thing about OmniWeb 5 - it provides you with complete, and I mean complete control over your browsing experience. 

Of course OmniWeb lets you do things like blocking ads, killing pop-ups (and pop-unders), and managing which plug-in content you want 
to see. BUT WAIT, THERE’S MORE! You also have a ton of control over how preferences work. Go ahead and tweak the internet to your liking 
- for your default browsing experience, and also for specific sites.

Let’s say you typically like to block ads, but your favorite Mac news site has ads you actually find useful. All you have to do is change the 
Ad Blocking preferences for that one site, and presto! Banners up the wazoo. You can change the font size for websites that you can’t read 
(because, grrrr, the type is too small) or that won’t fit on your display (because, arrgh, the type is too big), without making all websites change 
in the same way. You can even set site-specific defaults for downloading files.

Bookmarks

Preferences

About this Manual



SETTING AND OVERRIDING OMNIWEB 5 PREFERENCES

Like we keep saying, OmniWeb 5 lets you control almost every aspect of your browsing experience. Your 
basic approach to setting up your browser should be to decide how you want OmniWeb to behave most 
of the time. Use the application preferences to set these behaviors as the default. Then set site-specific 
preferences to override the defaults on specific web pages where you want different behavior.

What can I control using preferences?

Huh? Why would I want OmniWeb to spoof a website about what browser I am using?

How do I get OmniWeb to store user names and passwords for various web sites? 

Is it safe to have OmniWeb store my passwords?

What stuff can I block?

How do I block pop-ups and pop-unders?

How does OmniWeb let me know about blocked ads?

How do I block advertising?

What kinds of plug-in content can I block?

How do I block plug-in content?

What kind of control can I exercise over cookies?

How do I set the preferred window size and location?

How do I override general preferences for a specific domain?

How do I move my preferences to a different computer?



What can I control using preferences?

Almost everything about the way you surf the web can be controlled using OmniWeb’s application 
preferences. To get to the OmniWeb Preferences pane, select Preferences… from the OmniWeb menu. 

General Preferences
• Start Page
• Location bar auto-completes URLs as you type
• OmniWeb displays favicons (for websites that have them)
• Navigate by voice
Tabs and Windows
• Tab drawer opens
• Window behavior, including whether a window appears at 

start-up, whether links open in the same window or a new 
window, and the behavior of alternate link-clicking key 
combinations

Display 
• Page-drawing starts
• Clicked links look different than unclicked links
Bookmarks
• Bookmarks show in the current browser or a new window
• OmniWeb checks all bookmarks for changed page content
• How to file new bookmarks
• Share your bookmarks on the Local Area Network (LAN)
• Synchronize your bookmarks across multiple Macs
Downloads
• OmniWeb should remember what files you have downloaded 

from where
• Handle downloads, including setting applications which can 

automatically open downloaded files

This is the Preferences pane, you can use it to configure these settings

For detailed information about these preferences, please refer 
to the online help. Note that any preference pane can be set 
back to its defaults by clicking on the reset  button. If you press 
the Option key, this button will reset all. That way, you can 
reset all the preferences to OmniWeb’s original settings.

History
• Save History information between sessions
• Save, if you decide to save it
• Space to allocate for caching web content, and how often to 

validate that content.
AutoFill
• Information can be used to autofill web forms
• Create and manage a library of phrases that can be 

automatically completed if you ever type them again in a 
web form

Shortcuts
• Create and manage shortcuts that you can type into the 

Location bar to get to a web page quickly
Source View
• Configure the HTML source editor, with colors and 

highlighting to distinguish HTML code from content
• OmniWeb to help you update pages that you create and 

publish to the World Wide Web
Plug-ins
• Discover which plug-ins will handle what kind of MIME 

content
• Disable specific plug-ins you don’t wish to have loaded
Update
• Configure OmniWeb to check http://www.omnigroup.com 

for updates on a regular basis

Appearance
• Determine how OmniWeb will display pages, including 

selecting font sets, determining whether links will be 
underlined, and how images will be handled

Ad Blocking
• Deal with pop-ups and pop-unders
• Determine how many times animated images should play 

their animations (hence eating CPU) before they stop
• Create general defaults for blocking ads
• Create and manage lists of ad source sites from which you 

never (or always) want to see ads
Languages
• Set text encoding preferences for rendering pages and 

submitting forms
• Attempt to get web pages in your favorite language
Security
• Control how Javascript, Java and cookies are allowed to run 

within OmniWeb



Huh? Why would I want OmniWeb to spoof a website about which browser I am using?

Some websites display different content depending on which browser they think you are using. A particularly irritating example of 
this is websites that detect what browser you’re using, and then proceed to lecture you about how their website is optimized for a 
different browser. The worst cases are websites that flat-out refuse to load if they don’t like your browser choice. 

OmniWeb does a good job of displaying most web pages as-is, but at times you may want to set OmniWeb to identify itself as some 
other browser (called “spoofing”) - for instance, if your banking site thinks you should be using Internet Explorer. For any given 
site/domain you can tell OmniWeb, using the Other tab of Site Preferences, what browser it should report itself as. 

Overall, we’d like you to only spoof when it’s really necessary - you want people who design websites to know what browser you’re 
using. Ideally, websites should support as many browsers as possible. Internet Diversity: It’s A Good Thing.

How do I get OmniWeb to store user names 
and passwords for various web sites? 

On the AutoFill Preferences pane, click on the check box labeled 
“Prompt to save usernames and passwords.”

Is it safe to have OmniWeb store my passwords?

Naturalmente. OmniWeb stores password information in the secure Keychain provided by Mac OS X. 



How do I block pop-ups and pop-unders?

On the Ad Blocking Preferences pane, you can choose to allow pop-
ups to load, or you can tell OmniWeb never to load pop-ups, or you 
can have OmniWeb only load pop-ups when you have specifically 
asked for them (by clicking on a link that is set up to open a pop-up). 
You can also tell OmniWeb to show blocked pop-ups in the Status 
Bar.

How does OmniWeb let me know about blocked windows?

You can have OmniWeb block pop-up windows, including the annoying kind that lurk under your main browser 
window, only to surprise you much, much later (“Gah! No, I do NOT want that webcam!”). You can also set up 
OmniWeb to block images that might be ads, and images that are located on a different website than the one 
you’re viewing.

What stuff can I block?
FREE!!!!!

If you set your preferences to show blocked ads in the Status Bar, then OmniWeb will load - but 
not open - pop-up windows. Instead, an icon will appear in the Status bar at the bottom of the 
browser window indicating that there are pop-up windows that have been trapped. 

Click on it to show a menu listing all the trapped pop-ups for the current tab. To open a pop-up, 
just select it from this menu.



For example, there are standard sizes for banner ads on web sites. If you want 
OmniWeb not to load images that are these standard sizes, click the check box 
labeled Matching known ad sizes.

How do I block advertising?

By blocking pop-ups (or at least unrequested pop-ups), you can block a LOT of 
the advertising that comes along with web browsing. But! OmniWeb can try to 
be even smarter, if you want. On the Ad Blocking Preferences pane, you can tell 
OmniWeb how to handle certain images that are part of a web page you are 
loading.

Most ads aren’t loaded from the web site where you view them - typically, the 
web page you are looking at loads advertising content from a third-party site. 
OmniWeb can refuse to do this, if you click the check box marked From third-
party sites.



In the section called “Load anything from sites matching these expressions, 
regardless of other settings”, you can override all Ad Blocking settings, including 
loading from third party sites, image sizing, and so on. Any domain you enter in 
this area will be allowed to load images, regardless of other settings. 

If you want to edit the list of blocked sites, click on the button labeled “Edit Blocked 
URLs List…”. In the “Don’t load anything from sites matching these expressions” 
area, you can add sites whose linked content you don’t want to see. 

Lots of ads are propagated through well-known ad sites. If you would like 
OmniWeb to block images and other inline content that loads from one of these 
sites, click the box labeled From blocked URLs. 



You can disable any kind of registered plug-in content.

How do I block plug-in content?

If you do want to accept cookies, you can still control how this is done. To decline cookies that are sent from a site other than the one 
you are viewing, click next to Only from the current site.

To throw away all cookies from a session when you shut down OmniWeb, click the box labeled Discard when quitting OmniWeb. 
You can always view the cookies you’ve received from a website by clicking the cookie icon in the status bar.

What are cookies, and how can I control them? 

Web cookies are bits of data placed on your computer when you browse 
websites. (Note: you cannot eat them.) Sometimes they allow websites to 
track what you’re viewing, and sometimes they recognize your computer 
when you visit the website again (for instance, so you don’t have to log 
back in to certain sites). On the Security Preferences pane, you can 
configure how OmniWeb handles cookies. If you don’t want to accept any 
cookies at all, just uncheck the box labeled Accept cookies. 

What kinds of plug-in content can I block?

Go to the Plug-ins Preferences pane. This panel shows a list of all plug-ins; next to 
each plug-in is a check box.     

To block content that uses that plug-in, uncheck the box. 

Note: before changes to this panel can take effect, you need to restart OmniWeb.   



Set your browser window to a size and location that makes you happy, then select Save Window Size from the Window menu. The 
next time you open a new browser window, it will open like the saved one - except that if there is already a window in that location, 
it will ever-so-politely offset itself to the right to avoid completely covering the existing window. 

OmniWeb 5 preferences are stored in a file (located wherever your preferences are stored, usually in ~/Library/Preferences) called 
com.omnigroup.OmniWeb5.plist. If you need to move your preferences to another computer, just copy this file into the same folder 
on the new computer.

How do I set the preferred window size and location?

How do I override general preferences for a specific domain?

Load a page from the domain whose preferences you want to alter. Select the Show 
Site Preferences from the OmniWeb menu.

On the bottom half of the browser window, the Site Preferences pane will appear. In 
the same pane, you can also choose to see the Page Info pane.

As you page through Page Appearance, Ad Blocking, Languages, Security, and 
Other, you’ll see that they are the same as the general preference panes we just went 
over. Hooray! Here, you can make different choices for these items, and the choices 
you make will apply only to pages in the same domain as the current page you’re 
looking at. You can tell what domain that is by looking at the label of the pane.

If you make any changes so that a site-specific preference is different than your 
defaults, a small blue button appears to the right of the preference. If you want to 
revert to the defaults you have set, click that button.

How do I move my preferences to a different computer?



How do OmniWeb 5 tabs work?

What are all those little icons that sometimes appear on my tabs?

What are the shortcuts I can use with tabs?

I have too many tabs! How can I see them all?

How can I tell the difference between two tabs that look very similar?

How do I move a tab from one window to another?

What else should I know about tabs?

OMNIWEB TABS

You might be familiar with the idea of tabbed browsing - or maybe 
this is your first foray into the Wonderful World of Tabs. OmniWeb 5 
has an expanded notion of tabs as compared to other browsers, and 
this section will (hopefully!) answer any questions you might have 
about the tabs interface.



What are all those little icons that sometimes appear on my tabs?

How do OmniWeb 5 tabs work?

OmniWeb stores tabs in the kind of drawer that is familiar to you from other Mac OS X applications. You can put this drawer on the 
left or right of your browser window by customizing your Tab & Window preferences. In the drawer, each tab appears as a thumbnail 
image of the web page it represents.

You can drag and drop tabs between one window and another. You can also copy and paste a tab from one window to another. If 
you don’t like the order in which the tabs appear in the drawer, simply drag and drop to rearrange. 

Tabs provide status information through icons. 
When the content represented by a tab is still 
loading, a rotating icon appears on the tab. 

When a tab that you haven’t viewed yet is done 
loading, a green check-mark appears on the 
thumbnail. 

If there was a error loading a tab, a yellow 
exclamation point icon appears on the tab.

Here are the icons you might encounter while using OmniWeb.



I have too many tabs! How can I see them all?

Aahhhh! The horror! No really, it’s okay - you have two choices. You 
could make the thumbnails smaller by making the tab drawer narrower. 
This stops being useful pretty quickly, since as the thumbnails get smaller, 
it gets harder to tell them apart. (Note that if you change the size of the 
tab drawer, the next time you create a tab drawer on a window, it will 
remember the changed size and use that.) The better choice is probably 
to switch from the thumbnail view to the list view of the tabs. You do this 
by clicking on the list icon at the top of the tab drawer.

What are the shortcuts I can use with tabs?

Command-T creates and selects a new tab.
Command-option-T shows the tab drawer.
Command-click defaults to “Open in a new, inactive tab”. You can use the Tabs & Windows preferences to change how this 
shortcut works. Your choices are:

Open in a new, inactive tab
Open in a new active tab
Open in a new window behind the current window
Open in a new window in front of the current window

When you have two or more tabs in a window, Command-W closes the current tab. In this case, Command-Shift-W closes 
an entire window and all its tabs (after you’ve confirmed that yes, you want to do this).
Double-click on a tab in order to open it in its own window.



What if I want the tab in both the first window and the second window?

How can I tell the difference between two tabs that look very similar?

You can just drag it from the tab drawer in the first window to the tab drawer in the second window. The tab will disappear from the 
first window and appear in the second window.

If you want to load a link or bookmark into a pre-existing tab, drag either the link or the bookmark on top of it.

How do I move a tab from one window to another?

Well, you could click on each one in turn, and compare the web pages that are displayed. Or you could hover your mouse over 
the tab, which will display a handy tooltip with full tab title and address. Another choice is to make the drawer bigger. Since the 
thumbnails always size themselves to fill the width of the drawer, widening the drawer is a quick way to make them larger. This 
should make it easier to tell them apart.

What else should I know about tabs?

You can turn a bookmark into a tab by dragging it into the tab drawer. Groovy, no? You can even drag an entire folder of 
bookmarks and create a whole slew of tabs all at once. 

If you open more than one HTML file from your hard disk at once (by selecting a bunch of files all at once, and then using Open 
With…, for example), they will load into a single window, each file turning into a tab.

In that case, click on the thumbnail of the tab you want in both places. Copy the selected tab to the clipboard. Then select the 
destination browser window and paste the tab into the new window. It should appear in the tab drawer. Voila!



WORKSPACES

If you’re like most people, you use your web browser for lots of different types of online activities - shopping, 
running auctions, reading blogs, banking, and so on. As you’re working on one particular activity, tra la la, 
browse browse browse, surf surf surf, you might end up with several different windows open, arranged 
juuuust so on your desktop...everything set up perfectly for what you’re doing. Awesome. Except, what 
happens when you need to switch to a different activity? Or shut down your web browser for a bit? D’OH! 

With OmniWeb 5, you can save and manage all that stuff by archiving any particular setup as a named 
workspace. Let’s say you create a “cooking” workspace. Now you can open and save several different recipe 
related websites - the next time you want to use the same arrangement of windows, you just click on “Cooking” 
in your workspace list, and ta daaaa - it all reappears. 

In addition, you can take snapshots of a workspace. This lets you try out new combinations of windows and 
screen arrangements, and if they don’t work out, then you just go back to the snapshot version. Which, happily, 
makes playing around with your workspaces risk-free.

How do I set up a workspace?

What does a workspace know about the windows in it?

What is the default workspace?

How do I move between two or more workspaces?

How do I move windows into an existing workspace?

How do I take a snapshot of a workspace?

How do I return a workspace to an earlier snapshot?

What are all the things I can do in the Workspaces pane?



How do I set up a workspace?

Select New Workspace from the Workspace menu. Give your new workspace a name 
and click on OK.

To see that your workspace has been created, check the bottom of the Workspace menu. 
Your new workspace has been added to the list of workspaces.

What does a workspace know about the windows in it?

When you create a workspace, you can tell OmniWeb whether or not to save the windows in the workspace. This choice is on by 
default, and is what makes OmniWeb open the workspace next time just as you left it when you quit the browser.

What is the default workspace?

In OmniWeb 5, you are always working in a workspace. Even if you haven’t created any new workspaces yet, the application creates 
one called Default. The default workspace starts out with the auto-save while browsing feature turned off. This means that when you 
quit the browser out of this workspace, OmniWeb forgets about the windows, and the next time you start OmniWeb, you get only 
one window with your Start Page in it.

(We set the default workspace up this way so that you don’t have to know - or care - about workspaces if you don’t want to. If you 
use only the default workspace and you don’t change the auto-save while browsing setting, then OmniWeb 5 acts like previous 
versions of OmniWeb when you shut down and start up the browser.)

A workspace can be set to remember all the windows you have open, including: 

• Tabs (including whether your tabs are shown with thumbnails or in a list)

• Browsing history

• Whether each window is minimized or not

• Scroll position of each window



How do I move between two or more workspaces?

How do I move windows into an existing workspace?

There are three ways to do this.

If you are in one workspace and you open a window that you realize you would 
like to have in another workspace, open the Workspaces pane. Your current 
window will be listed in the highlighted workspace. Drag it over to the left side of 
the pane and drop it on the name of your target workspace.

Moving through Workspaces
On the Workspace menu, use Next Workspace and Previous Workspace to cycle through all 
your workspaces. There are keyboard shortcuts for these actions, too: Command-Control-
<RightArrow> shows the next workspace and Command-Control-<LeftArrow> shows the 
previous workspace. F-key shortcuts (F1 through F8 keys) are automatically assigned to your 
first eight workspaces.

The Workspaces Pane
Open the Workspaces pane by selecting Show Workspaces from the Workspace menu. 
In this pane, you’ll find a list of all your workspaces. Double-click on the one you wish 
to use, and OmniWeb will switch to that workspace.

Workspace Menu
Select the workspace you want to use from the Workspace menu.

Method 1 

Method 2 

Method 3 



How do I take a snapshot of a workspace?

How do I return a workspace to an earlier snapshot?

What are all the things I can do in the Workspaces pane?

In the Workspaces pane, select the workspace you wish to record. Click on 
the icon at the bottom of the pane to create the snapshot. When the snapshot 
is complete, the same icon will appear next to the name of the workspace.

If you decide you want to get rid of the snapshot, just close all browser 
windows and take a snapshot of the empty workspace. If you always want a 
workspace tp start from its snapshot, turn off “Auto-save”.

If you decide you liked a workspace better when you took the snapshot of it than you do now, you can revert to the snapshot.

Drag windows between workspaces

Modify the auto-save while browsing setting for each workspace

Rename a workspace by Option-clicking the name of the workspace or by carefully clicking the name of an already selected workspace

Single-click a workspace icon to see the windows in that workspace

Double-click an item in the workspaces list to activate the workspace.

The Workspace Menu
Make sure that the workspace you want to restore is the active workspace. Then select Restore Snapshot from the Workspace menu.

The Workspaces Pane
In the Workspaces pane, select the workspace you want to restore. Click on the icon to restore the workspace to the way it 
was when you took the snapshot.

There are two ways to do this.

Method 1 

Method 2 



OMNIWEB BOOKMARKS

In OmniWeb 5, your bookmarks are, in many ways, the heart of your browsing experience. OmniWeb bookmarks 
work well with lots of other tools and technologies to provide you with an integrated browsing experience.

Where can I find my bookmarks?

How do I import my bookmarks from another browser?

How do I make a new bookmark?

Where can I find more information about a particular bookmark?

Can I rename my bookmarks?

What is the bookmark shelf?

How can I organize my bookmarks?

What are the columns in the bookmarks display?

How can I sort my bookmarks?

I know I bookmarked that page! How can I find it?

What are those icons next to my bookmarks and folders?

How do bookmarks interact with tabs?

What are all those bookmarks that came with OmniWeb 5?

How can I check to see which bookmarks have new content?

How can I check to see which bookmarks have become useless pointers to nothing?

How do I share my bookmarks with others on my network?

Can I use my bookmarks to help me deal with complicated web pages that have a lot of links on them?

What happens to a bookmark if the web site it points to does a permanent redirect?

Can I make bookmarks that take advantage of XML/RSS feeds?



Where can I find my bookmarks?

How do I import my bookmarks from another browser?

Bookmarks appear in a wide editing area (this is a change from 
previous versions of OmniWeb, where bookmarks appeared in a 
drawer). You can either open your bookmarks in the browser window 
or in their own window. OmniWeb 5 ships with bookmarks opening in 
the browser window; you can change this, if you like, in the Bookmarks 
preferences. 

Once you have set your preferences, you can always make bookmarks 
open the other way by holding down the Option key while you open 
the bookmarks.

When you open bookmarks in the browser window, OmniWeb treats it 
as a web page for History purposes. This means you can move in and 
out of bookmarks by using the Back and Forward toolbar buttons.

The first time you run OmniWeb 5, it automatically imports your bookmarks from 
OmniWeb 4.x. What? You mean bookmarks from some other browser? Oh, all right.

Select Import Bookmarks… from the Bookmarks menu. 

Use the drop-down menu to select the browser you want to import from. Click Import. 
If the browser you want is not listed in the menu, click Choose Other… and use the 
navigation window to find the bookmarks file you want to import.



Where can I find more information 
about a particular bookmark?

Can I rename my bookmarks?

Select the bookmark and click Command-I. This brings up the Bookmark 
Info panel at the bottom of the browser window. 

One especially cool thing about this window is that it lets you create a 
Keyword for your bookmark. Once you have done this, you can quickly 
navigate to the bookmarked page by typing the keyword in the Location 
bar.

In this area, you can also set a different schedule for checking this bookmark 
for updates. You can even force OmniWeb to check for updates right now. 

Also, this is where you can enter notes about your bookmarks most easily. 
And w00t, the notes are searchable.

Yes. If you want to rename them when creating them, make sure you bring up the optional pane described previously. To rename 
an existing bookmark, select it, and then single-click on it. This will allow you to type a new name for it.

How do I make a new bookmark?

The easiest way is to bring up the page you want to bookmark in your active window 
and then select Add to Bookmarks… from the Bookmarks menu.  The first time you 
ever do this, a pane appears asking you to specify a bookmark folder and a name 
for the new bookmark. When these choices are correct, click on OK.

If you don’t want to see this pane again, be sure to click the box next to the words 
“Don’t show this again”. If you check it (so thereafter most bookmarks use the page 
title for their name and are placed in the folder you specified in the Bookmark 
preferences), you can get the pane to come up when you need it for a particular new 
bookmark: just hold down the Control key while you select the menu item.

I



What is the bookmark shelf?

In the bookmarks window, the shelf is the area to the left of the list of bookmarks. It contains two 
lists, separated by a divider. Above the divider is a list of collections, and below the divider is a list 
of your top-level bookmarks folders. By clicking on one of these items, you tell OmniWeb what 
bookmarks to display in the main part of the window.

Use the icon at the bottom left of the shelf to add and subtract your collections from the visible list. 
You can simply drag the collections around to reorganize their order.

Address Book: all the URLs in your Address Book

History: your browser history

Most Visited: the 8 sites that you have visited most often

Local Web Servers: OmniWeb uses Rendezvous to list all web servers on your local network

My Shared Bookmarks: a holder for bookmarks you want to share with other OmniWeb 5 users; simply copy items into this collection 
and other OmniWeb 5 users on your LAN can then see your shared bookmarks in their Shared Bookmarks collection.  Note: You can 
only share bookmarks if you have turned on Bookmarks Sharing in Bookmarks preferences 

Shared Bookmarks: the bookmarks being shared by other OmniWeb 5 users on your local network

Site Preferences: a list of all domains for which you have custom preferences set (select a domain — and then View > Show > Site 
Preferences if necessary — to see the custom preferences; you can delete a domain from the list to remove all preferences for that 
domain)

Unreachable: a list of all bookmarks for web pages that were unavailable for one reason or another the last time OmniWeb tried to 
check the bookmark for changes

Unviewed Content: a list of those bookmarks that have been updated since you last viewed them

[Other browser name] Bookmarks: if you imported bookmarks, a collection is created for each browser you got bookmarks from, 
and every time you restart OmniWeb, it checks to see if your [other browser] bookmarks are changed; if so, this collection will be updated 
to reflect the changes

The collections are:



How can I organize my bookmarks?

What are the columns in the bookmarks display?

You can create folders to hold your bookmarks. To create a folder, you can use the Actions icon at the bottom of the main 
bookmarks list; select Add Bookmarks Folder from the pop-up menu. Or, you can simply click on the Add Folder icon. You can 
drag bookmarks into folders and nest folders as deeply as you care to. The Actions icon menu also lets you create separators for 
your bookmarks, which you can drag to the location where you want them.

To change which columns are displayed, Control-click on any column heading and use the context menu that appears to select 
which columns should be visible. To move columns around, just drag and drop them, using the column headers as handles.

Note: annotations you make to your bookmarks

Visit Count: how many times you have visited this bookmark

Searchable by Content: which displays a magnifying glass if you can search the page content

The bookmarks display has several columns, which you can configure as you please. By default, the columns displayed are:

Status: shows new content 
or unreachable content

Address: the URL associated with the 
bookmark (for folders, this column shows 
the number of items in the folder)

Last Visited: the date you 
last viewed the page the 
bookmark points to

There are three other columns that, by default, are not displayed:

Label: the bookmark name



How can I sort my bookmarks?

I know I bookmarked that page! How can I find it?

What are those icons next to my bookmarks and folders?

How do bookmarks interact with tabs?

Click on a column heading to sort using that column’s content. There is a three-stage cycle when you click on a column heading. 
The first click sorts all the bookmarks, using the contents of that column to decide what order to put them in. The second click sorts 
in reverse of that column order (in other words, it turns the list upside down from how it was sorted on the first click). The third click 
takes you back to the order you created manually.

At the bottom of the bookmarks window, there is a search field. In the shelf, select the bookmark folder or 
collection that you wish to search. Then enter a search phrase and press Return. 

You can control the scope of the search by using the drop-down menu on the search field. Just select the 
scope you wish to apply to the search from the menu, and proceed.

In the Status column, OmniWeb displays two different icons to show you the status of your bookmarks.

The green checkmark means that there is new content on that page since the last time you visited it. The 
yellow exclamation point means that the page has become unreachable.

You can create tabs by dragging bookmarks into the tab drawer. You can even drag a folder of bookmarks into the drawer, 
creating a whole bunch of tabs all at once. If you drag a folder into the browser window instead, OmniWeb replaces the current 
tabs with tabs created from the folder contents.



How can I check to see which bookmarks have become useless pointers to nothing?

How do I share my bookmarks with others on my LAN?

Copy the items you want to share (both individual bookmarks and entire folders) to the My Shared Bookmarks 
collection. Then other OmniWeb 5 users on your network will be able to see and use your shared bookmarks. 
Bookmark sharing needs to be enabled in your preferences for this to work (it’s on by default).

When OmniWeb checks a bookmarked site for updates, it may discover that the webpage has become 
unavailable. If this happens, a yellow exclamation point will appear in the status column in the main bookmarks 
area. This icon will also attach to containing folders for the affected bookmark.

How can I check to see which bookmarks have new content?

You can tell OmniWeb to automatically keep track of this for you. 
Once you have visited a bookmarked site, if the content changes, a 
green checkmark appears in the status column in the main bookmarks 
area. Also, the OmniWeb 5 icon in the Dock shows the number of 
updated bookmarks.

What are all those bookmarks that came with OmniWeb 5?

Top-level bookmarks folders appear below the divider on the bookmarks shelf. OmniWeb 
5 ships with a bunch of bookmarks folders to get you started. If you like them, great! If not, 
feel free to get rid of them and make your own.



Can I use my bookmarks to help me deal with complicated web pages that have a lot 
of links on them?

What happens to a bookmark if the web site it points to redirects to a new location?

Can I make bookmarks that take advantage of XML/RSS feeds?

Absolutely. Just drag a URL to the shelf to create a folder full of the links from that page, now turned into bookmarks. Or, you can bring 
the page up in the browser window and then click on the View Links as Bookmarks icon on your Navigation Bar. (This item is not on the 
toolbar by default, but can be added.)

To make it even easier to navigate these bookmarks, you can drag the folder to the tab drawer. All the links now appear in the drawer 
(just be aware that if any of the links are mailto: links, dragging the folder to the tab drawer will open an outgoing mail message for you 
in your email client). This information will be kept up to date as the page changes.   

OmniWeb 5 transparently updates the bookmark address for you. Good OmniWeb! You get a biscuit!

Yes. When you are browsing a page that advertises an RSS feed to 
OmniWeb, a newspaper icon will appear in the status bar at the bottom of 
the browser. Click on it and give the news feed a location and a name. It 
will appear as an ordinary bookmark. You can also click a link to the feed 
if the site provides one.                  



OTHER COOL STUFF IN OMNIWEB 5

In this section, we answer other burning questions 

to help you make better use of OmniWeb 5.

If I see something cool on the Web, what’s the easiest way to send a link to a friend?

How can I save content to my hard disk?

How does OmniWeb 5 help me manage my downloads more effectively?

What are all those little icons at the bottom of the browser? And why do they keep changing?

How can I make poking around the web more convenient without proliferating my bookmarks out of control?

What are these “shortcuts” I can set in Preferences?

What’s with the changes to History?

What AppleScript support is there for the new features in OmniWeb 5?

How can I send you feedback about this application?



If I see something cool on the Web, what’s the easiest way to send a link to a friend?

How can I save content to my hard disk?

Select Send Link… from the File menu. This will create a message in your email program that you can address and send to your friend.

There are TONS of ways to do this.

Summarize the Current Page and Save It
Click on the Summarize button on the toolbar. This will take you to a summary created by Apple’s SummaryService, which 
you can save to your hard disk.

Save the Current Page as PDF
Select Print… from the File menu. From the Print dialog, click on the Save As PDF… button.

Save all the Linked Documents on the Current Page
Select Save Linked… from the File menu. From the sub-menu, select Documents… . again, you’ll be asked to select a target location for the 
download. And again, when you have done so, OmniWeb will download all the linked documents from that page to the specified location.

Save all the Linked Images on the Current Page
Select Save Linked… from the File menu. From the sub-menu, select Images… . You will now be asked to select a target location for 
the download. When you have done so, OmniWeb will download all the linked images from that page to the specified location. 

Save the Current Page as HTML
Select Save As… from the File menu. This lets you save the current web page as an HTML document to your hard disk. Note 
that this only captures HTML, and not images, style sheets, or scripts.

Method 1

Method 2 

Method 3 

Method 4 

Method 5 



What are all those little icons at the bottom of the browser? And why do they keep changing?

The Status Bar icons are added and removed dynamically, in response to the currently loaded page. Each of these icons either acts 
as a button to perform an action, or it displays a menu of choices.

The buttons are:

Load Images: There are unloaded images on the page. Click this to load them.

How does OmniWeb 5 help me manage my downloads more effectively?

• The downloads window now uses a real toolbar that can be customized.
• The downloads window is now a drag target for links. Just drag a link to the window to start a new download.
• Abandon has been added as an option on the Downloads window. Abandon will stop the currently selected download(s), and 

remove them from the list.
• You can now resume interrupted downloads (as long as the server the file is coming from supports it). Use the Resume toolbar 

button to resume a download.

Site Preferences: Appears in the Status Bar when viewing a site that has custom preferences set. Click on it to access those preferences.

Cookie Sheet: A cookie icon appears whenever there are cookies for the current page.

Add Search: This item appears when your cursor is active in a search field on a web page. Click the icon to create a Shortcut for 
searching the site that is accessible from the toolbar search field.

News Feed: When there is an available news feed (RSS or XML feeds) on the current page, click this button to subscribe to the feed.

AutoFill forms: Click it to AutoFill any form(s) on the page. Option-clicking it to save the values currently entered in the form into 
your currently active AutoFill set.

Blocked Pop-ups:  When there are trapped pop-ups for the current page, this button appears on the status bar. Click it to display 
a menu listing the trapped pop-ups for the life of the current site.

In OmniWeb 5, we’ve given you a lot more control over downloading files. Here are some of the new features:



How can I make poking around the web more convenient without proliferating my 
bookmarks out of control?

Use Page Marks to create temporary fast links in your History. This allows you to poke around in the links on a web site, surfing to your 
heart’s content, and then get back to the hub of your explorations quickly. You can either use the Mark page command on the History 
menu, or you can place the Marks commands on the Navigation Bar. In any case, there are four commands that you will find useful:

Mark this page: places a mark on the 
page to make it easier to get back to later

Once you have several marked pages, the last two commands cycle you through them all.

Note that pages that are returned as the result of a search are always marked, as is any visit to the Bookmarks page. The first page 
viewed in a particular window is also marked.

Unmark this page: removes 
the mark on the current page

Go to Previous Mark: loads the most recently marked 
page before the one you are looking at right now

Go to Next Mark: loads the next marked page (“next” is 
determined relative to the page you are currently viewing.



What are these “shortcuts” I can set in Preferences?

OmniWeb shortcuts are totally, completely, and thoroughly cool. They let you create short abbreviations so that you can navigate to 
your favorite websites quickly, with just a few keystrokes. You can also put the shortcuts search field on the toolbar, for easy visual 
access.

Shortcuts allow you to quickly get to web sites by typing an abbreviation instead of their full URL. There are a few shortcuts that come 
with OmniWeb, most notably one that allows you to get to any site with a URL like “http://www.foo.com” by just typing the unique part, 
“foo”. 

You can add and remove shortcuts from the list using the +and -buttons below the table. For example, if you have no interest in the 
Omni Metalcraft Corp whose address is <http://www.omni.com> and would like to get to our website (awww, thanks!) by typing just 
“omni”, you can add a new line with “omni” in the Shortcut column and “http://www.omnigroup.com” in the URL column. 

As you can see, the Google shortcut is more complicated than some of the others. The first thing that is different about it is that the name of 
the shortcut is defined to be “google@”. Yet, when you typed the shortcut, you did not type the “@”. That is because the “@” is just a signal 
to OmniWeb that this shortcut is used with additional text (the additional text is called an “argument”, because that’s how geeky programmers 
talk). 

Now look at the URL that is tied to the shortcut. The URL as it appears in the list is http://www.google.com/search?ie=utf8&oe=utf8&q=%@. 
The “%@” means “put the argument here”. 

Therefore, if you typed “google omniweb”, this would translate into the URL http://www.google.com/search?ie=utf8&oe=utf8&q-omniweb. 

 

Try typing “google omnigroup” in the address field of the OmniWeb window. 
Press Return. Now look at the browser. You will notice two things:

1. The browser page is now the results page for a Google search on the term “omnigroup”.

2. The address bar content has been replaced with http://www.google.com/search?ie=utf8&oe-utf8&q=omnigroup

What’s going on here? Look at the Preferences Shortcuts pane again.



What AppleScript support is there for the new features in OmniWeb 5?

What’s with the changes to History?

How can I send you feedback about this application?

We moved History to Bookmark collections to standardize the way you search for pages in OmniWeb 5, as well 
as to add more power to searching. One of the things we gained by doing this is that History entries now have 
all the attributes of bookmarks, including date last visited and visit count. 

In OmniWeb 5, we added AppleScript support for tabs and workspaces. Support includes:

Select Send Feedback… from the Help menu. We have a truly awesome Support 
team, and they will actually read and respond to every suggestion you make.

Tabs

� Add, move and remove tabs from browsers

� Ask for and set the tab address

� Reload and Stop tabs

Workspaces

� Change the name of a workspace

� Set the active workspace

� Move browser windows between workspaces

Check the online help for more information about Applescript support.



OMNI HELP SECTION

Stuck on something? Excited by the gory details? OmniWeb’s online help system can answer most any question that you 
might have. (Questions that aren’t about OmniWeb will have less useful answers.)

And if the online help system isn’t quite enough, you can always e-mail us and we’ll get back to you as soon as we can.

OmniWeb’s online help system.

Online help pages.

What if that is not enough?

Opens the online help pages.Links to a page with props to the folks 
who have contributed to OmniWeb.

Clicking here will tell your e-mail client to start a message 
addressed to our feedback address. You can tell us what 
you like, any problems you have, or really anything that’s 
on your mind. (We can’t fix everything in the world, but 
we’ll try our best.)

Takes you to the OmniWeb home page, 
where you can find out more about 
OmniWeb, download the latest version, 
get help, or check out our other products.



OmniWeb’s online help is a set of web pages, 
organized by topic. Each topic presents all the 
detail that can be provided on a given subject, 
with links to related topics.

Our online help is intended to be an exhaustive 
reference, whereas this manual is aimed at 
giving an introduction to the broad concepts in 
OmniWeb. So, as we keep saying, if you don’t find 
enough detail here on any particular topic, please 
look in the online help.

What if that’s not enough?

And finally, if you’re still stuck, you can always send us e-mail at:
omniweb5@omnigroup.com

Maybe other users have had the same problem. There’s a great and very helpful community on our mailing list:
http://www.omnigroup.com/applications/omniweb/omniweb-l/

There’s always our web site-check here for updates, tips, and other breaking news.
http://www.omnigroup.com/applications/omniweb/

Online Help Pages

The Internet is a big place, and everyone uses computers in a different way. So if our help system isn’t enough, here are some other options.












